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1 Installing Instructions

1.1 Installing D-Geo Flow as Delta Shell plugin

1.1.1 Installing D-Geo Flow

After downloading the D-GeoFlow(version number ).msi, this file should be double-clicked in
order to start the installation wizard. The install wizard will take you through the installation
process including the creation of program shortcuts. Please select the ’Standard’ installation
profile when prompted. After installing DS-FLEX the *.lic file needs to be registered. Once
done, D-Geo Flow is ready to be used.

1.2 Starting D-Geo Flow

1.2.1 Starting D-Geo Flow for the first time

As mentioned in the previous section, the installation wizard will create a program shortcut
in both the Windows Start Menu as well as on the desktop. Please select one of the two to
launch D-Geo Flow.
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2 A Guide to this manual

2.1 Introduction

This User Manual concerns the (un)saturated groundwater flow and piping module D-Geo
Flow.

2.2 Overview

To make this manual more accessible we will briefly describe the contents of each chapter.

This manual consists of the following chapters. In Chapter 3: ‘Module D-Geo Flow: an
overview’ on page 5 the D-Geo Flow module is explained on a general level. In Chapter 5:
‘Module D-Geo Flow: Getting started’ on page 23 is explained how to get started with the
D-Geo Flow module.

D-Geo Flow contains the following Key Features:

� 2D transient saturated and unsaturated groundwater flow calculation

� Sellmeijer model implemented for predicting pipe progression

� Complex subsurface/multi-layer configuration definition through user interface

� Application of time dependent hydraulic loads

� Graphical and numerical presentation of output of groundwater flow and pipe develop-
ment over time

2.3 Versions and Revisions

This is version 1.0.1 of the User Manual.

2.4 Known issues and recommended settings

In this version of D-Geo Flow Deltares acknowledges the following known issues:

� In the drawing mode: sometimes, when due to overlapping geometric objects (e.g. soil
layers) the intersections results into very small, sharp-edged triangles, the meshing of
these triangles will fail or are not meshed properly.

� In the drawing mode: moving of individual points by using the mouse is disabled.

For this version of D-Geo Flow Deltares recommends the following settings:

� To use boreholes for generating (sub)soil geometries.

� To set the decimal symbol to a ’point’.
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3 Module D-Geo Flow: an overview

3.1 What is D-Geo Flow

Software module for groundwater flow simulations and for modeling piping under dikes and
dams. D-Geo Flow uses the Delta Shell User Interface in combination with the Finite Element
Model DgFlow which includes a piping module.

3.2 System Requirements

Processor Intel i5 Dual Core 2 GHz

RAM Minimal 1 GB

Disk space 500 MB (excluding model and project files)

Screen resolution 1280 x 1024, 64 bit color depth (recommended)

3.3 The Delta Shell framework

D-Geo Flow is a Delta Shell plugin. For more information about Delta Shell, see next chapter.
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4 Delta Shell Basics

4.1 Windows

As Delta Shell is an integrated modelling suite, the application is project-based. Within a
project several models may be run and combined.

The main user interface is organized in a set of tool and document windows. An example
is given in Figure 4.1. The tool windows show properties of the current project, whereas
document windows are used to visualize or edit a specific data type. Tool windows can be
docked where you prefer — even at a second display. Document windows are, when placed
within the framework, always in the central area but may also be docked stand-alone (on a
second display, for example). Examples of tool windows are:

� Project
� Map
� Region
� Properties
� Chart
� Data
� Time navigator
� Messages
� Toolbox

Examples of document windows are:

� Map(s)
� Editor(s)

Figure 4.1: Overview of the graphical user interface, example for a SOBEK 3 model.

In this chapter all tool windows, menus, dockable views, context menus, and ribbons and
toolbars will be described. Map functionality and the spatial editor are treated in separate
chapters. The specific editors for the different models are described in the user manuals
belonging to those model plug-ins.
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4.1.1 Projects

The Project window is the main navigation window for the project data, showing the total
workspace in a tree view (Figure 4.2). In the Project all project components are shown. For
a project containing a one-dimensional flow model and a map these may look like:

� The model (in this case a 1-dimensional flow model)
� The model input

◦ The network(s)
◦ The computational grid(s)
◦ The initial conditions
◦ The boundary conditions
◦ Lateral data
◦ Roughness
◦ Wind data

� The model output/results
� The map

All project items with sub-levels can be collapsed by a mouse-click on the ‘−’ sign in the tree
view. Project data can be sorted by adding new folders to the project tree view and moving
models or movable items to designated folders. By clicking on the top left icon in Figure 4.2
the active item in the central Map is located in the tree view.

Figure 4.2: The project tree window.
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Several possibilities exist to work with the tree view:

� Left mouse-click to select
� Right mouse-click gives a context menu with available actions
� Double-click to show a map or editor in the main (central) window, depending on the

parameter

4.1.2 Main (central) window

The main window (Figure 4.3) is by default always placed in the middle of the screen. It can
also be docked separately, for example on a second display. It is used to present a map for
all geo-referenced modeldata, the editors for other data, and results in charts. The editors for
other data are model-specific and therefore described in the manuals for the various model
plug-ins.

All items with a geo-reference will be presented on the central map, for example: network,
computational grid and output data as layers, comparable to a geographical information sys-
tem (GIS).

Figure 4.3: The central map view.

When working in the central map, for example on a network, it is possible to add, adjust or
delete network components, which is described thoroughly in the D-Flow 1D manual.

Results in charts windows (Figure 4.7) are presented by combining a table view and a ’xy’-
plot. The user can visualize separate data points by selecting rows in the table view. The data
that is presented in the chart window may also be exported to a *.csv file by clicking the Csv
export button.
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Figure 4.4: The chart window view.

4.1.3 Map

The Map window (Figure 4.5) manages the active map. In this window layers within the active
map can be shown, hidden or adjusted. With the four icons in the top left of the window new
<shp>- or <wms>-layers can be added, removed or exported. With the icons in the top
right of the window, the window can be removed or hidden. The window can be retrieved by
clicking on Map in View ribbon.
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Figure 4.5: The map window.
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4.1.4 Data

The Data window (Figure 4.6) can be used to inspect the contents of available data items,
when selected in the project window.

Figure 4.6: The Data window.

4.1.5 Chart

The Chart window (Figure 4.7) can be used to stack/unstack chart series of the same type or
to convert chart series to a certain type (area, line, point, or bar series), Furthermore, series
can be selected or deselected within this window.

Figure 4.7: Example of the chart window.

4.1.6 Region

In the Region window (Figure 4.8) all hydrological objects are shown, like river-networks,
-catchments or waterbodies. The Region window is related to the selected model. While
in the central map the model objects are arranged according to their spatial location, the
Region sorts the model objects by category and chainage. A component that is selected in
the Region window is also automatically selected in the central map and vice versa.
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Figure 4.8: Example of the region window.

4.1.7 Toolbox

In the Toolbox window (Figure 4.9), users can quickly add a variety of items (models, stand-
alone items) to the project tree, by selecting ’Add new item’ or ’Add new model’ after a right-
mouse-click on the desired item. Furthermore, users may manage their Python scripts within
the Toolbox window.

Figure 4.9: Example of the Toolbox window.
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4.1.8 Properties

The Properties window shows properties for an active selection of the graphical user inter-
face. When a model object is selected in the Region window it shows the properties of this
object. Accordingly, the Properties window of an item selected in the Project shows data
related to the selected item, for example the simulation time of a <flow model> or a list with
output parameters when clicking on the <output> entry. Figure 4.10 shows an example for
the properties of a flow model.

In the Properties window data can also be edited. If the property grid is insufficient to display
the information, for example in case of time series, an additional editor can be opened.

Figure 4.10: Example of a property grid in the properties window of a flow model.

4.1.9 Time navigator

The Time navigator is used to navigate through time(steps) of any time-dependent variable.
An example is given in Figure 4.11. Each map or side view that shows time-dependent vari-
ables has its own time navigator. Users may also play results of time-dependent variables
continuously.

Figure 4.11: Example of the Time navigator window.
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4.1.10 Messages

The Messages window (Figure 4.12) is a logging window. Messages sent from models or
different parts of the system are shown here. When a message is too large to fit within the
Messages window, the user can open a single message (Figure 4.13) separately by right-
mouse-clicking the message and selecting the ’Show details’ option.

Figure 4.12: The messages window.

Figure 4.13: The message detail window.

Within the Messages window the user may select the verbosity of the shown messages,
ranging from ’Info messages’ to ’Warning messages’ to ’Error messages’. It is also possible

to clear all messages by clicking .

Furthermore, a run report is shown in the output in the Project for each model simulation.
This run report contains all the messages (from Delta Shell and the model plug-ins) that occur
during a simulation.

Finally, an application log is kept for each session of Delta Shell in the project database. In
this log-file, which can be accessed through the File/Help or Home menus, all messages are
stored.

4.2 Dockable views

The Delta Shell framework offers lots of freedom to customize dockable views, which are
discussed in this section.

4.2.1 Docking tabs separately

Within the Delta Shell framework the user can dock the separate windows according to per-
sonal preferences. These preferences are then saved for future use of the framework. An
example of such preferences is presented in Figure 4.14, where windows have been docked
on two screens.
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Figure 4.14: Docking windows on two screens within the Delta Shell framework.

4.2.2 Multiple tabs

In case two windows are docked in one view, the underlying window (tab) can be brought to
the front by simply selecting the tab, as is shown here.

Figure 4.15: Bringing the Time Navigator window to the front

By dragging dockable windows with the left mouse button and dropping the window left, right,
above or below another one the graphical user interface can be customized according to
personal preferences. Here an example of the Time Navigator window being docked above
the Properties window.

Figure 4.16: Docking the Time Navigator window.

Additional features are the possibility to remove or (auto) hide the window (top right in Fig-
ure 4.16). In case of removal, the window can be retrieved by a mouse-click on Time Navigator
in the View ribbon. Hiding the Time Navigator window results in:
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Figure 4.17: Auto hide the Properties window

4.3 Ribbons and toolbars

The user can access the toolbars arranged in ribbons. Model plug-ins can have their own
model specific ribbon. The ribbon may be auto collapsed by activating the Collapse the Ribbon
button when right-mouse-clicking on the ribbon.

4.3.1 Ribbons (shortcut keys)

Delta Shell makes use of ribbons, just like Microsoft Office. You can use these ribbons for
most of the operations. With the ribbons comes shortcut key functionality, providing shortcuts
to perform operations. If you press Alt, you will see the letters and numbers to access the
ribbons and the ribbon contents (i.e. operations). For example, Alt + H will lead you to the
Home-ribbon (Figure 4.18).

Note: Implementation of the shortcut key functionality is still work in progress.

Figure 4.18: Perform operations using the shortcut keys
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4.3.2 File

The left-most ribbon is the File ribbon. It has menu-items comparable to most Microsoft
applications. Furthermore, it offers users import and export functionality, as well as the Help
and Options dialogs, as shown in Figure 4.19 and Figure 4.20.

Figure 4.19: The File ribbon.
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Figure 4.20: The Delta Shell options dialog.

4.3.3 Home

The second ribbon is the Home ribbon (Figure 4.21). It harbours some general features for
clipboard actions, addition of items, running models, finding items within projects or views,
and help functionality.

Figure 4.21: The Home ribbon.

4.3.4 View

The third ribbon is the View ribbon (Figure 4.22). Here, the user can show or hide windows.

Figure 4.22: The View ribbon.
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4.3.5 Tools

The fourth ribbon is the Tools ribbon (Figure 4.23). By default, it contains only the Open
Case Analysis View tool. Some model plug-ins offer the installation of extra tools that may be
installed. These are documented within the user documentation of those model plug-ins.

Figure 4.23: The Tools ribbon contains just the Data item.

4.3.6 Map

The last ribbon is the Map ribbon (Figure 4.24).

Figure 4.24: The Map ribbon.

This will be used heavily, while it harbours all Geospatial functions, like:

� Decorations for the map

� North arrow

� Scale bar

� Legend

� ...

� Tools to customize the map view

� Select a single item

� Select multiple items by drawing a curve

� Pan

� Zoom to Extents

� Zoom by drawing a rectangle

� Zoom to Measure distance

� ...

� Edit polygons, for example within a network, basin, or waterbody

� Move geometry point(s)

� Add geometry point(s)

� Remove geometry point(s)

� Creation of a model Network, for example for D-Flow 1D

� Add new Branch

� Split Branch

� Add Cross section
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� Add Weir

� Add Pump

� ...

Still, all functions of the category can be activated as they will appear in the drop-down panel.

4.3.7 Scripting

When you open the scripting editor in Delta Shell, a Scripting ribbon category will appear.
This ribbon has the following additional options (see also Figure 4.25), which are described in
Table 4.1:

Figure 4.25: The scripting ribbon within Delta Shell.

Table 4.1: Functions and their descriptions within the scripting ribbon of Delta Shell.

Function Description

Run script Executes the selected text. If no text is selected then it will
execute the entire script

Clear cached variables Clears all variables and loaded libraries from memory
Debugging Enables/Disables the debug option. When enabled you can

add breakpoint to the code (using F9 or clicking in the mar-
gin) and the code will stop at this point before executing the
statement (use F10 (step over) or F11 (step into) for a more
step by step approach)

Python variables Show or hide python variables (like _var_) in code comple-
tion

Insert spaces/tabs Determines if spaces or tab characters are added when
pressing tab

Tab size Sets the number of spaces that are considered equal to a
tab character

Save before run Saves the changes to the file before running
Create region Creates a new region surrounding the selected text
Comment selection Comments out the selected text
Convert to space indenting Converts all tab characters in the script to spaces. The num-

ber of spaces is determined by Tab size
Convert to tab indenting Converts all x number of space characters (determined by

Tab size) in the script to tabs
Python (documentation) Opens a link to the python website, showing you the python

syntax and standard libraries
Delta Shell (documentation) Opens a link to the Delta Shell documentation website (gen-

erated documentation of the Delta Shell api)

4.3.8 Shortcuts

The shortcut keys of the scripting editor within Delta Shell are documented in Table 4.2.
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Table 4.2: Shortcut keys within the scripting editor of Delta Shell.

Shortcut Function

Ctrl + Enter Run selection (or entire script with no selection)
Ctrl + Shift +
Enter

Run current region (region where the cursor is in)

Ctrl + X Cut selection
Ctrl + C Copy selection
Ctrl + V Paste selection
Ctrl + S Save script
Ctrl + - Collapse all regions
Ctrl + + Expand all regions
Ctrl + " Comment or Uncomment current selection
Ctrl + W Add selection as watch variable
Ctrl + H Highlight current selection in script (press esc to cancel)
F9 Add/remove breakpoint (In debug mode only)
F5 Continue running (In debug mode only — when on break-

point)
Shift + F5 Stop running (In debug mode only — when on breakpoint)
F10 Step over current line and break on next line (In debug mode

only - when on breakpoint)
F11 Step into current line if possible, otherwise go to next line

(In debug mode only — when on breakpoint). This is used
to debug functions declared in the same script (that have
already runned)

4.3.9 Quick access toolbar

Note: The user can make frequently used functions available by a single mouse-click in the
Quick Access Toolbar, the top-most part of the application-window. Do this by right-mouse-
clicking a ribbon item and selecting Add to Quick Access Toolbar.

Figure 4.26: The quick access toolbar.
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5.1 Starting a D-Geo Flow model

In this chapter it is explained how to get started with D-Geo Flow. The tutorial describes gen-
eral procedures for the creation of a geometry model, the assignment of soil properties and
boundary conditions, the generation of a finite element mesh, the execution of a calculation
and the visualisation of the results.

5.1.1 Problem definition

In this tutorial a first application is considered, namely the piping mechanism under a dike.

Figure 5.1: Pipe Formation.

A dike is built on a sandy aquifer covered by a cohesive top layer. The water level in the river
varies with time. The hydraulic gradient across the structure results in a groundwater flow
through the aquifer. Transient flow calculations with D-Geo Flow define the formation of a pipe
at the polder side and its backwards development from the toe up to the river side. It should
be noted that the results of transient flow piping analysis calculations are currently subject
of investigation. It is therefore recommended to start with incompressible flow analysis and
consult an expert before conducting transient flow piping calculations.

5.1.2 Start a new project

Open the Delta Shell GUI. On the Home tab, click on New Model

Choose D-Geo Flow Model.
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Figure 5.2: Starting a new D-Geo Flow project.

� Under the View ribbon, at the top of the window, you can select the boxes that you want
to visualize. Ensure that all the boxes are selected.

� In the project box, extend the tab Project1→ D-Geo Flow Model. Click on D-Geo Flow
Model icon.

� You can rename your model by a right mouse click on D-Geo Flow Model (the standard
name for a new model) and choosing Rename. Let’s call our model “Piping”.

5.2 Geometry schematization

5.2.1 Model properties

� Click on D-Geo Flow Model icon.

� Insert the model properties in the Properties box, as indicated in the figure below. The
properties can be visualized either in categorized or alphabetical order.
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Figure 5.3: Model properties.

The total calculation time is 1 day and the output results are produced every 5 minutes. The
results are visualized at every interval, meaning that the output time step results equal to the
time step used in the calculation. The meaning of MPicard, ErrLin and ErrNonLin is further
explained in ‘Scientific background’ on page 55. The working directory indicates where the
results are temporary stored. The results will be stored in a folder with the same name as the
file name. The advanced mode is set to False.

5.2.2 Soil stratigraphy

5.2.2.1 Soil parameters

� In the project box, extend the tab Project1→ Piping→ Input → Materials. Right-click
on the soils folder and select Add new soil.
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Figure 5.4: Add new soil.

� In the same way, create four more soil materials.

� Extend the Soil tab and click on New Soil that you just created.

� Insert the following properties in the Properties box:

Table 5.1: Material properties of the New Soils.

General

Name Dike Blanket Aquifer top
Blanket
polder side

Aquifer
bottom

Color
244; 164;
96

250; 128;
114

255; 228;
225 160; 82; 45 255; 215; 0

Other
Porosity [-] 0.4 0.5 0.3 0.5 0.5
Compressibility [m2/N ] 0 0 0 0 0
Grain particle
density, [kg/m3] 2650 2650 2650 2650 2650

Particle diameter,
D70 [m] 0.0001 0.0001 0.0002 0.0001 0.0001

White’s constant,
η [-] 0.25 0.25 0.25 0.25 0.25

Bedding angle,
θ [◦] 37 37 37 37 37

Permeability
Hydraulic conductivity -
KX [m/day] 0.01 0.01 10 0.01 30

Hydraulic conductivity -
KY [m/day] 0.01 0.01 10 0.01 30

5.2.2.2 Water properties

� In the project box, extend the tab Project1→ Piping → Input → Materials. Click on
the Water folder.

� Check that the following properties are assigned to the water:
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Figure 5.5: Water properties.

5.2.2.3 Soil layering (in boreholes)

� Right-click on the Boreholes folder and select Add new borehole. Double click on the
borehole just created and a new window will open.

� The first borehole is located at the x-coordinate equal to 0. Its top level is at -2 m and it
consists of two layers, namely Aquifer top from -2 m to -12 m and Aquifer bottom from
-12 m to -20 m.

� Place the pointer on top of the borehole and select Aquifer Top to assign this material
to the borehole.

� Right-click on the borehole in order to add new layers. Set the Top level at z = -2 m
and the first Level at z = -12 m. Assign Aquifer bottom to the second layer and set the
deepest level at -20m. Keep the X position at x = 0.

Figure 5.6: The generated borehole in the Borehole 1 window.
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� Add a second borehole. You can do it in two ways: you can right-click on the borehole
folder to add a new borehole as previously done, or you can right click on borehole 1
and select Create copy of Borehole 1. In this way, a new borehole, identical to Borehole
1, will be created.

Figure 5.7: Creating a copy of a selected borehole.

� In this way, create 12 boreholes as given in the following table:

Table 5.2: Boreholes of the model.

Borehole
number

X
position

Top
Level

Material
1st Layer Level

Material
2nd Layer Level

Material
3rd Layer Level

Material
4th Layer Level

1 0 -2
Aquifer
top -12

Aquifer
bottom -20

2 6 -2
Aquifer
top -12

Aquifer
bottom -20

3 10 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

4 20 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

5 32.5 5 Dike 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

6 37.5 5 Dike 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

7 48 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

8 58.25 0 Blanket -2
Aquifer
top -12

Aquifer
bottom -20

9 60 -2
Aquifer
top -12

Aquifer
bottom -20

10 63.75 -2
Aquifer
top -12

Aquifer
bottom -20

11 67.5 0
Blanket
polder side -2

Aquifer
top -12

Aquifer
bottom -20

12 100 0
Blanket
polder side -2

Aquifer
top -12

Aquifer
bottom -20

� Once you create the 12 boreholes, right click on the Boreholes folder and select Create
cross-section. The cross-section will appear after double-clicking on “Piping” (i.e. your
model).
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Figure 5.8: The generated cross section.

5.2.3 Boundary conditions

5.2.3.1 Types of boundary conditions

� Right-click on the Boundary Conditions folder in the project box and select Add sub-
merging boundary condition.

� Click in Submerging Boundary1 , that you just created, and, in the Properties box, set
the name to Riverside head boundary and the color to 75; 110; 187

� We assign the boundary condition in the form of head. Return to the project box and,
under the Riverside head boundary tab, double click on Head.

Figure 5.9: Add Riverside head boundary as Head in the boundary conditions of the
model.

� A new window appears. Select Table and Chart (single function)
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Figure 5.10: Select Table and Chart (single function).

� In the Head tab insert the boundary condition as given below:

Table 5.3: Boundary condition for the Riverside head boundary in the form of head.

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 2
2017-03-10 12:00:00 6.5
2017-03-11 00:00:00 2

Figure 5.11: Riverside head boundary in the Head window.

� Add a second boundary condition: select Add head boundary condition. In the Proper-
ties box, set the name to Polder level and the color to 186; 251; 97

� In the same way as described above. Set the following Time and Head:
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Table 5.4: Second boundary condition in the form of head.

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 0
2017-03-11 00:00:00 2

� You still need to define two boundary conditions. The first is a seepage boundary con-
dition. Therefore select Add seepage boundary condition. Rename it to ’Blanket polder
side’.

� The last boundary condition that needs to be assigned is the default no boundary con-
dition to the boundaries where no conditions are applied. This will be done later, first
we need to assign the boundary condition to the boundaries of our model.

5.2.3.2 Assigning boundary conditions

Now you have to assign the boundary condition to the model. You need to assign the boundary
conditions that you just created at the top of the model, as indicated in the figure below. The
default (no flow) boundary conditions will be then assigned to the three remaining sides of the
model.

Figure 5.12: Boundary conditions of the model.

� Go the the box Map→ extend the list→ uncheck the Boreholes checkbox. Do this in
order to make the boreholes invisible so all the boundaries can be selected .

Figure 5.13: Location of the Boreholes checkbox.
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� Select the line at the top left of the model. This line is defined as LINESTRING (0 -2,
6 -2) from the x and y- coordinates of its two points. In the Properties box, set the
Boundary condistion to Riverside head boundary.

Figure 5.14: Select a line and assign the boundary condition in the Properties box.

� Alternatively, you can left-click on the mouse and select an area. In such a way you can
assign a boundary condition to multiple lines.

Figure 5.15: Assign the boundary condition by selecting an area.

Pay attention that the boundary conditions have to be assigned both to the lines and to the
points. If boundary conditions are not assigned to some points, select the point and assign
the boundary condition.

� Once boundary conditions are assigned to the top of the model, you can assign default
no flow boundary condition to the remaining boundaries. In order to do so, right-click
on the Boundary Conditions folder in the project box and select Add default (no flow)
boundary conditions. Rename this boundary condition as “No Flow” and assign the
color (59; 218; 43)
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Figure 5.16: Assign default (no flow) boundary conditions.

Now all the boundaries of the model have assigned boundary conditions.

5.2.4 Pipe generation

� Right-click on the Pipe folder in the project box and select Add new pipe.

� Click in Pipe , that you just created, and, in the Properties box, set the name to start X
position to 6, the exit X position to 60 and the Y-Position to -2

Figure 5.17: Properties of the pipe.

The pipe runs horizontally from the dike toe at river to the bottom of the ditch to the dike side.
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Figure 5.18: Location of the pipe in the model.

5.2.5 Mesh generation

� Click on the Grid folder in the project box.

� In the project box, assign the coarseness of the mesh equal to 2.5 and the Pipe Coarse-
ness equal to 6.

Figure 5.19: Mesh properties.

� Now you can generate the mesh. Right-click on the Grid folder in the project box and
select Generate grid.

Figure 5.20: Mesh in the model
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5.3 Performing calculations

Before performing the calculation, you can validate the model in order to check if the model is
ready and calculations can be carried on.

� In the project box, right-click on the project tab and select Validate. A new window
appears: all the inputs have a green mark. The model is validated and calculations can
be done.

Figure 5.21: Validation of the model.

� In the project box, right-click on the project tab and select Run model.
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Figure 5.22: Run the model.

� A new window appears, which indicates the progress of the calculation.

Figure 5.23: The model is running.
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5.4 Visualization of results

There are several ways in which the results of the calculations can be visualised. This chapter
describes how to do so.

5.4.1 Point and grid results

The first way to visualize results is to select a point and obtain the results for that specific
point. In the Map box, unselect the Results.

Figure 5.24: Unselect the results in the Map box.

Now you can see the grid and select a point. Right-click and select Query time series.

Figure 5.25: Selection of a point for visualization of results.
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Select the results that you want to visualize, such as for example Head.

Figure 5.26: Selection of results to visualize.

You will now obtain a graph with Time in the x-axis and Head in the vertical axes.

At the same way, you can visualize the results for an element of the grid. Right-click on an
element and select Query time series, as previously done. You can visualize the results in
term of permeability in x direction, permeability in y direction and velocity

Figure 5.27: Selection of an element of the grid for visualization of results.

5.4.2 Profile results

You can also visualize the results along a profile for a specific output, while using the Time
Navigator.

� In the Map box, select only the Result that you want to visualize. Select, for example,
Head.

� In the Map tab sheet , at the top of the window, select Show Profile
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� Left-click at the left of the profile near point (0;-10) and double left-click at the right of
the profile, around point (100; -2).

Figure 5.28: Definition of Profile

� A new window Head profile will open with the values of the head along the chosen
profile.

Figure 5.29: Definition of Profile
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5.4.3 Time Navigator

Another way to visualize the results is to see how the parameters are changing in time within
the whole model.

In the Map box, select the Results in order to make them visible. Extend the tab Results and
select only Head.

Figure 5.30: Selection of Head in the Results.

In the Time Navigator window, you can run a simulation which shows the results in the main
window.
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Figure 5.31: Time Navigator.

5.4.4 Piping results

The results for the pipe are available in a different window.

� In the project box, extend the tab Project1→ Piping → Output → Pipe results. Here
you find the results for the pipe.
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Figure 5.32: Pipe results.

Double click on Equilibrium Head Drop. A new window appears asking if you want to visualize
the results in a table and chart with multiple functions or with only one function. Select the
second option, so that every result will be plotted in a different chart.

You will now see a graph with the applied Head Drop [m] versus the Pipe Length [m].

Figure 5.33: Results for the Equilibrium Head Drop.
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5.4.5 Export the results

There are two ways in which you can export the results:

1 Export the results in a Csv file by selecting the Csv export tab at the left top of the result
window.

2 Right click on the chart and select Export as Image..

Figure 5.34: Export the results.

5.5 Saving a D-Geo Flow model

You can save the model by selecting the save icon at the top of the Delta Shell GUI.

Figure 5.35: Save a model.
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5.6 Opening an existing D-Geo Flow model

If you, instead, want to open an existing model, you can do so in two ways. You can either
select the Import tab in the Home ribbon or you can right-click in the tab Project1 in the project
box and select Import.

Figure 5.36: Import a model.

Choose D-Geo Flow model importer from the available data.

44 of 63 Deltares



Module D-Geo Flow: Getting started

Figure 5.37: Open D-Geo Flow model importer.

You can now select the file that you want to open.
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6 D-Geo Flow Tutorial Cases

6.1 Description of the cases

This tutorial provides two examples for D-Geo Flow: a river dike and a sea dike. General
remarks are:

� In the current document the decimal point is used as a decimal separator (conform interna-
tional notations), note that D-Geo Flow requires a decimal point in your ’regional settings’
(Windows).

� Note that when 2 or more D-Geo Flow models are open in the same project, the save
function will only save the changes made to the project that is highlighted in the project
window.

� D-Geo Flow offers transient flow piping analysis. The results of these kind of analyses
are currently still subject of investigation. It is therefore recommended to start with in-
compressible flow analysis and consult an expert before conducting transient flow piping
calculations.

6.2 Pilot Case 1: River dike

6.2.1 Start-up project

1. Start-up D-Geo Flow
2. In the top taskbar, click on File→ New
3. In the Home tab, in the Project window, right-click on the project and click on add→ New

Model . . .
4. Select the D-Geo Flow Model and press on OK.
5. On the top taskbar click on File→ Save As and safe your project as River_dike_tutorial in

your preferred folder.

6.2.2 Input

1. 1 In the Project window, go to River_dike_tutorial -> D-Geo Flow Model. In the proper-
ties window, set the Start time to: 2017/03/10 00:00:00; set the End time to: 2017/03/11
00:00:00; set the number of Time steps to 288 (i.e. 5 minutes). For the steady state
calculations the time step in relation to the head increase is of importance because this
determines the head increase that is applied per calculation step. In the current example,
the head is increased by 4.5 m in 12 hours (see Table 6.1). This gives an increase of 0.03
m/time step.

The size of the head drop per time step affects the accuracy of the piping calculation. Other
factors that influence the accuracy are the mesh size, the accuracy with which parameter
values and boundary condition values are known and the accuracy of the schematisation. It is
noted that the rate of head increase does not influence the results for steady state calculations.

2. Set gravity to 10 and adapt MPicard to 1000. Do not adapt the other parameters under
settings. Note that if the value of gravity is changed during the project, the corresponding
hydraulic conductivity must be manually updated.

MPicard controls the stepsize by which the pipe height is adjusted to achieve equilibrium. The
stepsize is 100*D70/ MPicard. A larger stepsize (smaller MPicard) results in lower accuracy
but faster calculation
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3. In the Project window, go to River_dike_tutorial→ D-Geo Flow Model→ Input→ Mate-
rials→ Soils and right click on Soils and select “Add new soil”. Click on the newly added
soil.

4. In the Properties window Fill in the parameters for “Dike” stated in Table 6.1.
5. Repeat step 3 for all the other materials given in Table 6.1. It is recommended to use a

different colour for each material. It is also possible to right click a soil and select ‘Create
copy of ‘material name’ ’. Automatically a new soil material is created with the same
properties. This is a useful option for soils with the same parameters. Note that the grain
particle density, particle diameter, White’s constant and bedding angle values as given in
Table 6.1 for the case of the “Dike”,“Blanket”, “Blanket polder side” and “Aquifer bottom”
materials are not used further in the calculation analysis. Despite this, minimum allowable
values for the above parameters are specified in D-Geo Flow to avoid errors in the model
parameters validation report.

6. Set the water parameters as compressibility, β = 0 m2/N; density, ρ = 1000 kg/m3; vis-
cosity, µ =0.001 Ns/m2.

Table 6.1: Soil properties example 1, River dike

Name Dike Blanket
Aquifer
Top

Blanket
polder side

Aquifer
Bottom

Porosity [-] 0.4 0.5 0.3 0.5 0.5
Compressibility [m2/N] 0 0 0 0 0
Grain particle density [kg/m3] 2650 2650 2650 2650 2650
Particle Diameter D70 [m] 0.0001 0.0001 0.0002 0.0001 0.0001
White’s Constant η [-] 0.25 0.25 0.25 0.25 0.25
Bedding Angle θ [◦] 37 37 37 37 37
Hydraulic Conductivity – Kx [m/day] 0.01 0.01 10 0.01 30
Hydraulic Conductivity – Ky [m/day] 0.01 0.01 10 0.01 30

Table 6.2: Borehole data example 1, River dike

Borehole
nr 1 2 3 4 5 6 7 8 9 10 11 12

X Position 0 6 10 20 32.5 37.5 48 58.25 60 63.75 67.5 100

Layer 1
Aquifer
top

Aquifer
top Blanket Blanket Dike Dike Blanket Blanket

Aquifer
top

Aquifer
top

Blanket
polder side

Blanket
polder side

Top level
Layer 1 -2 -2 0 0 5 5 0 0 -2 -2 0 0

Layer 2
Aquifer
bottom

Aquifer
bottom

Aquifer
top

Aquifer
top Blanket Blanket

Aquifer
top

Aquifer
top

Aquifer
bottom

Aquifer
bottom

Aquifer
top

Aquifer
top

Top level
Layer 2 -12 -12 -2 -2 0 0 -2 -2 -12 -12 -2 -2

Layer 3 - -
Aquifer
bottom

Aquifer
bottom

Aquifer
top

Aquifer
top

Aquifer
bottom

Aquifer
bottom - -

Aquifer
bottom

Aquifer
bottom

Top level
Layer 3 - - -12 -12 -2 -2 -12 -12 - - -12 -12

Layer 4 - - - -
Aquifer
bottom

Aquifer
bottom - - - - - -

Top level
Layer 4 - - - - -12 -12 - - - - - -

Bottom
level -20 -20 -20 -20 -20 -20 -20 -20 -20 -20 -20 -20

7. In the project window, go to River_dike_tutorial→ D-Geo Flow Model→ Input→ Bore-
holes and right click on Boreholes and select “Add new borehole”. Double click on the
newly added borehole.

8. For the newly added borehole, in the borehole window, keep the X position at 0 and set
the Top level at -2 m.

9. In the borehole window, hover your mouse over the soil, a dropdown menu appears and
select Aquifer top. Set the bottom level at -12 m.

10. In the borehole window right click on the soil layer and select: “add layer”, in the dropdown
menu, select Aquifer bottom for the second layer. Set the bottom level at -20m. Repeat
Step 7 to Step 10 for the remaining boreholes, stated in Table 6.2. Note to always double
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click on the newly added borehole to view this borehole. Note it is also possible to add
boreholes by right clicking on a borehole and copying this borehole.

11. When all boreholes are created, in the project window, right-click on Boreholes and select
“create cross-section”.

12. In the project window, double click on D-Geo Flow model to view the geometry.
13. In the project window, go to River_dike_tutorial→ D-Geo Flow Model→ Input→ Bound-

ary Conditions. Right click on Boundary Conditions and select “Add Submerging boundary
condition”.

14. In the Project window click on the newly added boundary condition and change the name
to “Riverside Head Boundary” in the properties window. If preferred, the line colour of the
boundary condition can be changed in the properties window as well.

15. In the Project window, expand the Riverside Boundary and double click on Head. Select
“Table and Chart (single function)”.

16. Fill in the values as stated in Table 6.3.
17. Repeat Step 13 and add the boundary condition for the polder level with values stated in

Table 6.4.
18. Right click on boundary conditions and add a “Seepage boundary” and a “No-Flow” bound-

ary conditions. Name the above boundaries as “Polder side” and “No Flow” boundary
respectively.

Table 6.3: Riverside head boundary condition

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 2
2017-03-10 12:00:00 6.5
2017-03-11 00:00:00 2

Table 6.4: Polder level head boundary condition

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 0
2017-03-11 00:00:00 2

19. Assign the boundary conditions to the geometry. In the DgFlow Model window, click on
the geometry boundary lines and assign the relevant boundary condition in the Properties
window. It may be useful to uncheck the box boreholes in the map window. Multiple lines
can be selected at once by dragging a square around the lines or by pressing the ctrl key
and selecting multiple lines. In Figure 6.1, it is shown how the boundary conditions should
be assigned. Note that the boundary conditions are to be assigned on both the lines and
the nodes. In order to assign a boundary condition to a specific node it is necessary to
double click the node. When no boundary condition is assigned, the boundary is a no-flow
boundary, i.e. a zero flux boundary. In this example the zero-flux boundary conditions are
assigned manually.

20. When the Boundary conditions are assigned, the pipe can be defined. Go to
River_dike_tutorial → D-Geo Flow Model → Input → Pipes. Right click on Pipes and
select “add new pipe”

21. Click on the newly added Pipe. In the Properties window, In the Properties window, Set
Xstart to 6 m, Xexit to 60 m and Y to -2 m. First set “Y-Position” to -2 m and then “Start:X” to
6 m and “Exit:X” to 60m.

22. Click on River_dike_tutorial → D-Geo Flow Model → Input → Grid. In the Properties
window, change Defauly Mesh Coarseness to 2.5 and change Pipe Coarseness to 6. This
implies that the mesh elements have a general size of 2.5 m and the elements at the pipe
are refined by a factor 6.

23. Right click on Grid in the Project window and select Generate grid. In the D-Geo Flow
window check the appearance of the grid and the grid refinement. There is no automatic
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grid quality control in the D-Geo Flow GUI, however the Grid menu mesh quality statistics
are provided.

24. In the Project window, right click on D-Geo Flow Model and select “Run model” to start the
calculation.

Figure 6.1: Cross-section example River dike including boundary conditions. Light Red
is “No Flow boundary”, light blue is “River side boundary”, red is “Polder side
boundary” and green is “Polder level”

6.2.3 Output

1. In the model view window, a visual presentation of the output is shown. In the Map window
make sure that Map→ D-Geo Flow Model→ Results→ Head, is selected. In the Time
Navigator tab (bottom taskbar), click on play to see the development of the head in the
domain over time.

2. In River_dike_tutorial→ D-Geo Flow Model→ Output→ Pipe Results, time dependent
results of the calculation are presented in tables and graphs. These can be viewed by
double-clicking on the corresponding Pipe Result.

3. Double click on “Equilibrium head drop”→ “Table and Chart (Single Function)”. This shows
the applied head drop and the corresponding pipe length up to the critical pipe length. The
critical head drop is the last head drop before the pipe grows towards the other end of the
dike, i.e. the second to last head drop in the table, which is the highest head drop at which
the pipe is still in equilibrium condition. Please note that this value can be optimized by
increasing the number of time steps.

4. Double click on “Pipe Element Active” to view how the piping elements are activated over
time. If the piping element is breached, the value for “Active” is 1. If the pipe element is not
yet activated, its value is 2. Start the Time Navigator and search the first timestep where
all the piping elements are breached; this should agree with the head just above the critical
head.

5. Double click on “Head in Pipe” to view how the hydraulic head along the pipe path develops
over time. Navigate to one timestep before all the piping elements are activated. The
maximum head at this timestep is the critical head.

6.3 Pilot Case 2: Sea dike steady state calculation

6.3.1 Start-up project

1. Repeat Step 1 to Step 4 from Example 1.
2. On the top taskbar click on File→ Save As and save your project as “Sea_dike_tutorial”

in your preferred folder.
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6.3.2 Input

1. Repeat input Step 1 to 6 from Example 1, however fill in the soil properties stated in Ta-
ble 6.5. Note that the head increase per time step is now 0.035 m when 288 timesteps of
5 minutes are applied, since the head is increased to 5 m in 12 hours Table 6.7.

Although the load is applied in a time-dependent manner, the calculation is still steady-state as
long as the soil and water are incompressible. The rate of head increase is therefore irrelevant
for the result, other than that it controls the step size by which the head is increased.

2. Repeat input Step 7-10 from Example 1, however fill in the borehole data stated in Ta-
ble 6.6.

3. When all boreholes are created, in the project window, right-click on Boreholes and select
“create cross-section”.

4. In the project window, double click on D-Geo Flow model to view the geometry.
5. Analogous to input Steps 13→ 16 from Example 1, create a “submerging boundary” (Sea

side boundary), a “head boundary” (Polder Level boundary), a “No-Flow boundary” and a
“seepage boundary” (Polder side boundary) condition. Fill in the head values according to
the Table 6.7 and Table 6.8.

Table 6.5: Soil properties example 2, Sea dike

Name Dike Blanket
Blanket
polder

Aquifer
top

Aquifer
bottom

Porosity [-] 0.4 0.4 0.4 0.3 0.3
Compressibility
[m2/N] 0 0 0 0 0

Grain
particle density [kg/m3] 2650 2650 2650 2650 2650

Particle Diameter, D70 [m] 0.0001 0.0001 0.0001 0.0002 0.0001
White’s Constant, η [-] 0.25 0.25 0.25 0.25 0.25
Bedding Angle,θ [degrees] 37 37 37 37 37
Hydraulic
Conductivity, Kx [m/day] 0.01 0.01 0.01 10 30

Hydraulic
Conductivity, Ky [m/day] 0.01 0.01 0.01 10 30

Table 6.6: Sea dike Borehole data

Borehole
nr 1 2 3 4 5 6 7 8 9 10 11

X Position -20 4.8 8 45 47 77 100 101 105 106 150

Layer 1
Aquifer
top

Aquifer
top Blanket Dike Dike Blanket Blanket

Aquifer
top

Aquifer
top

Blanket
polder

Blanket
polder

Top level
Layer 1 0 0 4.1 14.1 14.1 4.1 4.1 0 0 4.1 4.1

Layer 2
Aquifer
bottom

Aquifer
bottom

Aquifer
top Blanket Blanket

Aquifer
top

Aquifer
top

Aquifer
bottom

Aquifer
bottom

Aquifer
top

Aquifer
top

Top level
Layer 2 -7.9 -7.9 0 4.1 4.1 0 0 -7.9 -7.9 -7.9 0

Layer 3 - -
Aquifer
bottom

Aquifer
top

Aquifer
top

Aquifer
bottom

Aquifer
bottom - -

Aquifer
bottom

Aquifer
bottom

Top level
Layer 3 - - -7.9 0 0 -7.9 -7.9 - - -7.9 -7.9

Layer 4 - - -
Aquifer
bottom

Aquifer
bottom - - - - - -

Top level
Layer 4 - - - -7.9 -7.9 - - - - - -

Bottom
level -15.9 -15.9 -15.9 -15.9 -15.9 -15.9 -15.9 -15.9 -15.9 -15.9 -15.9
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Table 6.7: Sea side head boundary condition

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 0
2017-03-10 12:00:00 5
2017-03-11 00:00:00 0

Table 6.8: Polder level head boundary condition

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 0
2017-03-11 00:00:00 0

6. Assign boundary conditions to the geometry. In the D-Geo Flow Model window, click on
the geometry boundary lines and assign per line the relevant boundary condition in the
Properties window. Multiple lines can be selected at once by dragging a square around
the lines or by pressing the ctrl key and selecting multiple lines. In Figure 6.2, it is shown
how the boundary conditions should be assigned. Note that the boundary conditions are
to be assigned on both the lines and the nodes.

7. When the Boundary conditions are assigned, the pipe can be defined. Go to Sea_dike_tutorial
→ D-Geo Flow Model→ Input→ Pipes. Right click on Pipes and select “add new pipe”

8. Click on the newly added Pipe. In the Properties window, change Start: X to -4.8; Y to 0
and End: X to 101.

9. When the complete model is defined, click on Sea_dike_tutorial → D-Geo Flow Model
→ Input→ Grid. In the Properties window, change Coarseness to 2.5 and change Pipe
Coarseness to 6.

10. Right click on Grid in the Project window and select Generate grid.
11. In the Project window, right click on D-Geo Flow Model and select “Run model” to start the

calculation.

Figure 6.2: Cross-section example 2 including boundary conditions (Blue: No Flow,
Green: Sea side Head, Purple: Polder side, Yellow: Polder level).
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6.3.3 Output

Check the results in a similar manner as in example 1. In addition, look into the distribution of
head and the pipe activation at different pipe lengths by checking the boxes ‘Results’, ‘Head’
and ‘Pipe’ in the map. Note that the applied head was insufficient for the pipe to progress
to the upstream side. To find the head drop at which the pipe will progress to the upstream
side, the calculation can be repeated with an applied head drop of 3 to 8 m by applying the
boundary conditions in Table 6.9.

Table 6.9: Adjusted sea side head boundary condition

Time [yyyy/MM/dd HH:mm:ss] Head [m]
2017-03-10 00:00:00 3
2017-03-10 12:00:00 8
2017-03-11 00:00:00 3
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7 Scientific background

7.1 Groundwater flow

7.2 Mathematical Model

The storage equation according to Richard’s model follows from the mass balance equation,
Darcy’s law and empirical relations for water content and relative permeability as a function of
pore pressure. This article adopts a Galerkin finite element discretization in space, in which
the primary field variable is pore pressure p (N/m2) Hughes (2000); Belytschko et al. (2008).
Pore pressures are considered to be positive in compression, with index notation being used,
xi (m) denotes Cartesian coordinates in space, t (s) denotes time, and Ω (m2) represents
the flow domain with Γ (m) its boundary.

7.2.1 Subsurface Flow Equation

Flow through a partly saturated porous medium can be modeled considering conservation of
mass and a generalization of Darcy’s law Van Esch (2010), which can be written as

(α + nβ)S
∂p

∂t
+n

dS

dp

∂p

∂t
+
∂qi
∂xi

= 0 , qi = −krκij
µ

(
∂p

∂xj
− ρlgj

)
on Ωp , (7.1)

where α (m2/N) is the compressibility of the soil skeleton, β (m2/N) represents the com-
pressibility of the pore water, n (−) denotes porosity and S (−) expresses the degree of
saturation of the liquid phase in the void space. The compressibility for elastic behavior of the
soil skeleton can be written as α = 1/(λ + 2ν), where λ (N/m2) and ν (N/m2) denote
Lamé’s constants. Specific discharge qi (m/s) relates to relative permeability kr (−), intrin-
sic permeability κij (m2), dynamic viscosity of the liquid phase µ (kg/ms) and its density ρl

(kg/m3). For a y-coordinate pointing in the opposite direction than the gravitational vector gy
is−9.81 m/s2. Equation (7.1) is known as the storage equation. Two types of boundary con-
ditions complete the problem definition; Dirichlet conditions prescribe the pressure on parts of
the boundary and Von Neumann boundary conditions prescribe the derivative of the pressure
or flux on the boundary. These first-type and second-type boundary conditions read

p = p on Γp
1 , qini = −q on Γp

2 , qini = −s on Γp
3 , (7.2)

where Γp
1, Γp

2 and Γp
3 are disjoint parts of the boundary where the conditions apply, ni (−)

denotes the outward pointing normal to the boundary, p (N/m2) is the prescribed pressure, q
(m/s) denotes the volumetric water flux over the boundary into the flow domain as a source
term, and s (m/s) expresses a source term that will be used for coupling the subsurface flow
equation to the flow equation for piping.

A weak form of equation (7.1) follows from multiplication by weighting functionsNa (−), which
are attached to nodes of a finite element mesh and integration over the flow domain. The first
weak form is given by∫

Ωp

Na (α + nβ)S
∂p̂

∂t
dΩ+

∫
Ωp

Nan
dS

dp

∂p̂

∂t
dΩ =

∫
Ωp

Na
∂

∂xi

[
krκij
µ

(
∂p̂

∂xj
− ρlgj

)]
dΩ ,

(7.3)

where the caret above a symbol implies that the variable is an approximation. Application of
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Green’s theorem to the term on the right hand side of equation (7.3) leads to∫
Ωp

Na (α + nβ)S
∂p̂

∂t
dΩ +

∫
Ωp

Nan
dS

dp

∂p̂

∂t
dΩ =

−
∫

Ωp

krκij
µ

∂Na

∂xi

(
∂p̂

∂xj
− ρlgj

)
dΩ +

∫
Γp
2∪3

Na
krκij
µ

(
∂p̂

∂xj
− ρlgj

)
nidΓ .

(7.4)

Galerkin weighting and substitution of the interpolation functions gives∫
Ωp

NaNb (α + nβ)S
dpb
dt
dΩ+

∫
Ωp

NaNbn
dS

dp

dpb
dt
dΩ = −

∫
Ωp

krκij
µ

∂Na

∂xi

∂Nb

∂xj
pbdΩ

+

∫
Ωp

krκij
µ

∂Na

∂xi
ρlgjdΩ +

∫
Γp
2

NaNbqbdΓ +

∫
Γp
3

NaNbsbdΓ , (7.5)

after the Neumann boundary conditions were incorporated. Prescribed boundary fluxes are
given at the nodal points. Implicit time integration yields∫

Ωp

NaNb (α + nβ)Sk+1
(
pk+1
b − pkb

)
dΩ+

∫
Ωp

NaNbn

(
dS

dp

)k+1 (
pk+1
b − pkb

)
dΩ =

−∆t

∫
Ωp

kk+1
r κij
µ

∂Na

∂xi

∂Nb

∂xj
pk+1
b dΩ + ∆t

∫
Ωp

kk+1
r κij
µ

∂Na

∂xi
ρlgjdΩ

+ ∆t

∫
Γp
2

NaNbq
k+1
b + ∆t

∫
Γp
3

NaNbs
k+1
b dΓ , (7.6)

where ∆t is the time step size, k denotes the current time step and k + 1 indicates the new
step.

7.2.2 Flow Equation for Piping

Modeling of piping follows from the application of conservation of mass and considering
Poiseuille flow Huyakorn and Pinder (1983) through a horizontal erosion slit and can be written
as

dq

dx
+ s = 0 , q = − a3

12µ

dp

dx
on Ωc , (7.7)

where a (m) denotes the height of the channel and s expresses a sink term. Here the
extension of the pipe flow domain Ωc (m) corresponds to the boundary of the subsurface
flow domain Γp (m) as equation (7.7) holds for a one-dimensional flow domain. Dirichlet
conditions hold on the inflow and outflow point of the piping domain. Boundary conditions for
the piping domain are given by

p = p on Γc
1 . (7.8)

The condition of limit equilibrium for the horizontally oriented erosion channel Sellmeijer (1988)
reads

a
dp

dx
=
π

3

(
ρs − ρl

)
gd70η tanϑ . (7.9)

The height of the erosion channel varies in between 0 and 3 grains in an experimental setup,
0 to 10 grains in a field test and 0 to 30 grains for an embankment.
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Discretization of equation (7.7) follows the same steps as the discretization of equation (7.1),
and the first weak form reads∫

Ωc

Na
d

dx

(
κp
µ

dp̂

dx

)
dΩ =

∫
Ωc

NasdΩ , (7.10)

where the equivalent intrinsic permeability κp (m3) has a scalar value that is given by κp =
a3/12. The second weak form is given by∫

Ωc

κp
µ

dNa

dx

dp̂

dx
dΩ = −

∫
Ωc

NasdΩ , (7.11)

and the final form follows from the substitution of interpolation functions∫
Ωc

κk+1
p

µ

dNa

dx

dNb

dx
pk+1
b dΩ = −

∫
Ωc

NaNbs
k+1
b dΩ . (7.12)

The condition of limit equilibrium for a horizontally oriented erosion channel is evaluated at
the integration points and is given by

κk+1
p = 1

12

(
ak+1

)3
, ak+1dNb

dx
pk+1
b =

π

3

(
ρs − ρl

)
gd70η tanϑ . (7.13)

7.2.3 Coupled Flow Equation

The sink term in equation (7.12), where s is positive for flow out of the channel, provides
a source term in equation (7.6), where s is positive for flow into the subsurface, and vice
versa. Linear one-dimensional elements are used for solving equation (7.12), whereas linear
triangular elements discretize the flow domain attached to equation (7.6). Combining both
equations yields∫

Ωp

NaNb (α + nβ)Sk+1
(
pk+1
b − pkb

)
dΩ+

∫
Ωp

NaNbn

(
dS

dp

)k+1 (
pk+1
b − pkb

)
dΩ =

−∆t

∫
Ωp

kk+1
r κij
µ

∂Na

∂xi

∂Nb

∂xj
pk+1
b dΩ + ∆t

∫
Ωp

kk+1
r κij
µ

∂Na

∂xi
ρlgjdΩ

−∆t

∫
Γp
3

κk+1
p

µ

∂Na

∂xi

∂Nb

∂xj
pk+1
b dΩ + ∆t

∫
Γp
2

NaNbq
k+1
b . (7.14)

The interface elements align along the horizontal axis. Picard iteration over κk+1
r and Sk+1

are used to resolve the non-linearities in the system of equations. Nonlinearities in κk+1
p are

resolved sequentially. For a given trial channel height, equation (7.13) provides the equivalent
intrinsic permeability, which is attached to the relevant interface element. The product of
channel height and pressure gradient are then compared with the equilibrium condition given
by the second part of expression (7.13).

More about validating the DgFlow kernel can be found in Taccari (2016)

7.3 More about piping

Figure 7.1 provides the sequential procedure graphically for a sample problem that includes
two interface elements that are in series. The height of the channel is presented as a function
of hydraulic head gradient. Hydraulic head h (m) is presented as h = p/(ρlg) + y, where
y (m) is the elevation level. The dark blue line represents the limit equilibrium condition; below
this line stable grain conditions apply and above the equilibrium line unstable conditions hold.
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Figure 7.1: Activation algorithm.

The calculation process starts by checking the interface element located to the downstream
side of the channel (element 1) next to the exit point. For a thickness of 0 mm the head
gradient is due to the flow process through the subsurface. Increasing the thickness of the
element increases the effective permeability of the element and decreases the gradient over
the element leading to the red line in Figure 7.1 (a). The height of the channel is increased
stepwise until the condition becomes unstable. This unstable situation is associated with the
first (right) point where the red line intersects the equilibrium line. At this point the element be-
comes active for the given head difference over the structure; a small increase in the channel
height pushes the element in the unstable zone. The permeability of the element is increased
until the element becomes stable again. The element thickness for which equilibrium holds
is obtained by means of a bisection algorithm. This second (left) intersection point denotes
a stable situation. If the height of the channel increases above this point, the element enters
the stable zone.

The procedure continues by checking the element on the upstream side (element 2) of the first
element (element 1). The plot on the right of Figure 7.1 illustrates this process. The height is
increased sequentially until the line enters the unstable zone and the second intersection point
is found, or a threshold value for the maximum channel height has been reached indicating
that the element will not be activated. For the depicted situation, the applied head difference
over the structure will not activate the second element. If equilibrium is not satisfied for the trial
element however, then the height of the already activated elements is modified accordingly
until equilibrium is satisfied within the entire pipe domain.

More about validating the piping module in D-Geo Flow can be found in Rosenbrand and Van
Beek (2017)
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7.4 Default and recommended settings

Table 7.1: material parameter ranges

parameter symbol minimum default maximum unit
particle diameter D70 1.00 · 10−4 2.00 · 10−4 8.00 · 10−4 m
density of the grains ρg 2.40 · 103 2.65 · 103 2.80 · 103 kg/m3

White’s constant η 0.20 0.25 0.30 −
bedding angle ϑ 30 37 50 deg
intrinsic permeability κ 10−16 1.157 · 10−11 10−10 m2

pore water density ρl 103 103 103 kg/m3

dynamic viscosity water µl 8.0 · 10−4 1.3 · 10−3 2.0 · 10−3 Ns/m2

gravitational acceleration g 9.00 9.81 11.00 m/s2

porosity n 0.2 0.36 0.9 −
minimal saturation Sr 0.0 0.00 1.0 −
maximal saturation Ss 0.0 0.36 1.0 −
Genuchten shape factor ga 0.3 2.24 2.5 1/m
Genuchten shape factor gn 1.0 2.286 2.5 −
Genuchten shape factor gl −6.0 0.00 1.0 −
compressibility soil α 10−10 1.0 · 10−7 10−5 m2/N
compressibility water β 10−10 5.0 · 10−10 10−5 m2/N
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